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ABSTRAK 

 

 

 

Aktivitas perekonomian yang bergerak dalam bidang industri yang berkembang 

sekarang ini sangatlah memerlukan sebuah transportasi ataupun alat yang dapat 

mengangkut dan mengirimkan produk-produk hasil industri tersebut, dalam hal ini 

yang dimaksud adalah sebuah mobil truk yang biasa digunakan untuk memuat 

barang dengan jumlah muatan yang terbilang sangat besar, mobil yang biasa 

digunakan untuk mengangkut beban umumnya menggunakan mesin diesel 

sebagai sumber tenaga penggerak pada mobil truk tersebut, oleh karena itu sangat 

lah penting peran dan daya tahan dari mesin diesel yang digunakan pada mobil 

truk tersebut demi kelancaran dalam proses pendistribusian produk-produk hasil 

perindustrian tersebut, yang menjadi fokus pada penelitian ini adalah blok silinder 

yang merupakan salah satu komponen yang berperan pada mesin diesel tersebut. 

Dan adapun rumusan masalahnya adalah bagaimana menganalisa struktur blok 

silinder dengan menggunakan program simulasi Ansys dengan variasi diameter 

tabung silinder dari ketiga model blok yang di desain. Serta penelitian ini 

bertujuan untuk mencari total deformasi dan tegangan maksimal dari ketiga model 

blok yang di desain.Penelitian ini menggunakan metode elemen hingga ataupun 

simulasi pengujian dengan menggunakan perangkat lunak komputer. Adapun 

sumber data yang digunakan berasal dari jurnal-jurnal dan buku-buku serta situs 

internet yang membahas tentang analisa numerik dan blok silinder.Berdasarkan 

analisa dan simulasi yang dilakukan, diperoleh data bahwa dariketigadesainmodel 

blok silinder dengan tekanan yang diberikan sebesar 27 bar, model blok yang 

memiliki diameter tabung silinder kecil dalam artian memiliki ketebalan dinding 

yang lebih besar mempunyai nilai total deformasi dan tegangan ekivalen yang 

kecil, begitu juga sebaliknya.  

 

Kata Kunci : Blok Silinder,Metode Elemen Hingga, Tegangan Ekivalen. 
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ABSTRACT 

 

 

 
Economic activity that is engaged in developing industries today requires a 

transportation or equipment that can transport and deliver products produced by 

the industry, in this case what is meant is a truck car that is usually used to load 

goods with a very large amount of cargo large, cars that are commonly used to 

carry loads generally use diesel engines as a driving force for the truck cars, 

therefore it is very important the role and durability of the diesel engine used in 

the truck cars for the smooth distribution process of the resulting products the 

industry, which is the focus of this research is the cylinder block which is one 

component that plays a role in the diesel engine. And as for the formulation of the 

problem is how to analyze the cylinder block structure by using the Ansys 

simulation program with variations in cylinder tube diameters of the three block 

models designed. And this study aims to find the total deformation and maximal 

stress of the three block models that are designed. This study uses finite element 

methods or simulation testing using computer software. The source of the data 

used comes from journals and books and internet sites that discuss numerical 

analysis and cylinder blocks. Based on the analysis and simulation, data obtained 

from the three cylindrical block model designs with a given pressure of 27 bar, 

the block model that has a small cylindrical tube diameter in the sense of having a 

larger wall thickness has a small total deformation value and equivalent stress, 

vice versa. 

 

Keywords: Cylinder Block, Finite Element Method, Equivalent Stress. 
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BAB 1 

PENDAHULUAN 

 

 

1.1.  Latar Belakang 

Perkembangan ilmu pengetahuan, teknologi dan kegiatan industri, 

terutama yang berhubungan transportasi dan ekspedisi pengiriman barang, sangat 

dibutuhkan fasilitas yang mampu bekerja keras untuk mengangkut muatan yang 

cukup banyak. Dalam hal ini yang dimaksud adalah mobil truk yang biasa dipakai 

untuk memuat barang-barang yang biasa digunakan untuk kelangsungan hidup 

manusia. Mobil truk yang digunakan untuk mengangkut beban umumnya 

menggunakan mesin diesel sebagai sumber tenaga penggerak pada mobil truk 

tersebut. 

Mesin diesel yang digunakan haruslah memiliki daya tahan kerja yang 

kuat agar proses pengangkutan ataupun pengiriman barang tidak terganggu atau 

bahkan menghambat proses pengiriman apabila terjadi masalah pada mesin mobil 

truk tersebut di tengah perjalanan. Dalam hal ini yang menjadi pokok pembahasan  

adalah blok silinder dari mesin diesel tersebut, dan yang menjadi titik acuan dari  

pengujiannya adalah struktur dari blok silinder itu sendiri. Pada pengujian ini akan 

dibuat 3 pemodelan blok silinder, dan ketiganya akan diuji untuk mengetahui 

perbandingan dari struktur ketiga blok silinder tersebut.  

Untuk mencari kekuatan struktur daripada model blok silinder yang akan 

diteliti, maka diperlukan sebuah program komputer yang dapat melakukan 

simulasi secara visual. Dalam hal ini yang dimaksud adalah  sebuah program dari 

perangkat komputer yang menggunakan metode elemen hingga yang dapat 

melakukan analisa numerik dari sebuah desain produk, yang dimaksud disini 

adalah program ANSYS v15. 

Dengan latar belakang ini maka penulis tertarik untuk mengadakan 

penelitian sebagai tugas sarjana dengan judul : “Analisa numerik pada struktur 

blok silinder mesin dengan variasi diameter tabung silinder”. 
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1.2.  Rumusan Masalah 

Perumusan masalah ini adalah bagaimana menganalisa struktur blok 

silinder dengan menggunakan metode elemen hingga, dengan variasi diameter 

tabung silinder dari blok silinder tersebut. Dalam hal ini yang dimaksud adalah 

simulasi dengan menggunakan program Ansys. 

 

1.3. Ruang Lingkup 

Untuk menghindari meluasnya masalah yang akan diuji, maka penulis 

akan membahas masalah yang berkaitan dengan analisa numerik ini, antara lain 

sebagai berikut : 

 Pemodelan blok silinder yang akan dianalisa menggunakan Software 

CATIA v5R19 

 Perangkat lunak yang digunakan untuk pengujian desain blok silinder 

ini berbasis finite element methode, yaitu software ANSYS v15 

 Analisa yang dilakukan hanya untuk mengetahui kekuatan struktur dari 

desain 3 model blok silinder tersebut. Dalam hal ini yang dimaksud 

adalah nilai total deformasi dan tegangan ekivalen 

 Metode simulasi yang digunakan adalah metode statis dengan 

pembebanan tekan dan beban yang bekerja ditetapkan sebesar 27 bar. 

 

1.4.     Tujuan 

 Adapun tujuan dari penelitian ini adalah untuk menganalisa secara 

simulasi pengujian kekuatan struktur pada blok silinder dengan variasi geometri 

yang pemodelannya sendiri dibuat menggunakan software CATIA v5R19 dan 

simulasi pengujiannya menggunakan software ANSYS v15. 

 

1.5.     Manfaat 

 Adapun manfaat dari penyusunan tugas sarjana ini adalah : 

1. Mendapatkan informasi tentang pengujian blok silinder dengan 

menggunakan metode analisa numerik. 

2. Dapat bermanfaat untuk penulis selanjutnya sebagai bahan referensi 

untuk pengujian blok silinder. 
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BAB 2 

TINJAUAN PUSTAKA 

 

 

2.1. Blok Silinder 

 Blok silinder adalah struktur terpadu yang terdiri dari silinder mesin bolak-

balik yang terdiri dari beberapa struktur pendukung didalamnya, seperti (saluran 

pendingin, saluran masuk dan pembuangan serta port, dan bak mesin). Istilah blok 

mesin sering digunakan secara sinonim dengan "blok silinder". Dalam hal dasar 

elemen-elemen mesin, berbagai bagian utama dari sebuah mesin (seperti silinder, 

kepala silinder, saluran pendingin, dan bak mesin) secara konseptual berbeda, dan 

konsep-konsep ini semua dapat dipakai sebagai potongan diskrit yang dibaut 

bersama-sama. konstruksi seperti itu sangat luas pada dekade awal komersialisasi 

mesin pembakaran internal (1880-an hingga 1920-an) dan kadang-kadang masih 

digunakan dalam aplikasi tertentu di mana ia tetap menguntungkan (terutama 

mesin yang sangat besar, tetapi juga beberapa mesin kecil). 

(Mukesh Annamneedi dan Jithendra : 2016) 

 Blok mesin adalah salah satu komponen mesin pembakaran internal yang 

paling banyak dimuat. Mereka harus memenuhi persyaratan mengenai daya tahan 

dan fungsionalitas. Blok mesin biasanya terbuat dari besi cor dan atau di mesin 

modern, aluminium dan magnesium digunakan sebagai bahan dasarnya. Beban 

yang bekerja pada blok mesin adalah beban termal, beban mekanis dll. 

(Suresh R : 2015) 

 Bagian-bagian lain dari sebuah mesin dipasangkan di dalam atau pada blok 

silinder,sehingga terbentuk susunan mesin yang lengkap. Pada blok silinder ini 

terdapat lubang silinder yang berdinding halus,dimana torak bergerak bolak-balik 

dan pada bagian sisi-sisi blok silinder dibuatkan sirip-sirip maupun lubang-lubang 

mantel air pendingin yang digunakan untuk sistem pendinginan dari mesin itu 

sendiri. 
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Gambar 2.1.Bagian-Bagian Blok Silinder 

2.1.1. Fungsi Utama Blok Silinder 

 Sebagai dudukan silinder liner dan kepala silinder 

 Sebagai rumah mekanisme engkol ( poros engkol, batang penghubung, piston, 

dll ) 

 Terdapat ruang dan lubang-lubang untuk aliran air pendingin dan sirkulasi oli 

yang masing-masing memiliki fungsi tersendiri 

2.1.2. Jenis Konstruksi Berdasarkan Susunan Silinder 

a) Tipe sebaris ( In Line ) 

Dalam konfigurasi sebuah mesin, mesin segaris adalah sebuah mesin 

pembakaran dalam yang semua silindernya terletak segaris. Mesin seperti ini 

sudah banyak digunakan di dunia otomotif, penerbangan, dan lokomotif.Mesin 

segaris lebih mudah dibuat dari mesin jenis lainnya, seperti mesin flat atau 

mesin V karena hanya membutuhkan satu cabang silinder dan crankshaft. 

Mesin ini juga membutuhkan cylinder head dan camshaft yang lebih sedikit. 

Mesin jenis ini memiliki keuntungan dari segi kemudahan dalam hal segi 

konstruksi dn pembuatan. Selain itu tipe mesin dapat dibuat kompak sehingga 

menguntungkan pada penempatan di dalam kabin mesin. Tentunya kalau ada 

keuntungan pasti ada kerugiannya, ya kerugian mesin jenis ini bila semakin 

banyak silindernya maka makin sulit dicapai kesimbangan ( balance dari mesin 

itu sendiri ). 
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Gambar 2.2. Konfigurasi blok silinder tipe sebaris 

b) Tipe V 

Sesuai namanya maka mesin ini berbentuk seperti huruf V dimana 

memiliki sudut tertentu, Cara termudah melihatnya coba anda amati motor 

Harley davidson. Ya itu adalah mesin tipe V. Mesin V pertama kali dipatenkan 

oleh Karl Benz pada tahun 1896 ), Dalam perkembangnya penamaan mesin V 

sesuai jumlah silindernya, V2 untuk 2 silinder, V4, V6, V8, V10, V12,V16, 

V18,V20, bahkan sampai ke V24 ( 24 silinder ). Mesin V memiliki Nilai 

gravitasi yang lebih rendah dan pengunaan pada mesin dengan silinder yang 

lebih banyak akan menghasilkan torsi maksimum yang lebih besar daripada 

mesin inline pada kapasitas mesin dan tehnologi yang sama. 

 

 

 

Gambar 2.3. Konfigurasi blok silinder tipe V 

c) Tipe Horizontal ( Boxer ) 

Jenis susunan silinder ini, yang pistonnya bergerak secara horizontal, dan 

dibagi menjadi 2 sisi berlawanan. Contohnya: mesin terdiri dari 4 silinder maka 

2 silinder terdapat pada sisi kiri dan 2 nya lagi terdapat pada sisi kanan. 
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Silinder untuk jenis susunan ini ditemukan oleh ilmuan asal Jerman pada tahun 

1986. Karakteristik dari jenis susunan ini adalah konstruksinya yang pendek, 

keseimbangan getaran lebih baik dari kedua jenis diatas, perlu 2 kolektor gas 

buang, dan saluran isap panjang jika hanya satu karburator. 

 

 

Gambar 2.4. Konfigurasi Blok Silinder Tipe Horizontal 

2.1.3. Material Yang Digunakan Dalam Pembuatan Bok Mesin 

Material yang banyak digunakan adalah cast iron dan allumunium alloy. 

Cast iron dipilih karena memiliki mechanical properties yang baik, murah, dan 

ketersediaannya cukup banyak. Alluminium alloys memiliki sebagian besar sifat-

sifat cast iron dengan berat yang lebih rendah. Selain itu, aluminium alloy juga 

memberikan surface finish yang baik dan juga machineability yang lebih tinggi 

daripada cast iron. Seiring dengan perkembangan teknologi, material baru pun 

ditemukan yaitu graphite cast iron yang lebih ringan dan kuat dibandingkan 

dengan grey cast iron. 

1. Grey Cast Iron Alloys 

Grey Cast Iron Alloys adalah material pertama dan paling banyak 

digunakan dalam pembuatan blok silinder. Meskipun alluminium alloy juga 

memiliki banyak persamaan dan lebih ringan daripada grey cast iron, material 

ini tetap digunakan dalam pembuatan blok silinder pada mesin diesel karena 

ketahanan stress internalnya lebih tinggi. Grey cast ironmengandung 2,5% –  

4% karbon, 1 – 3% silicon, 0,2 – 1% mangan, 0,02 – 0,25% sulfur, dan 0,02 – 

1% fosfor. Material ini memiliki penyerapan getar yang sangat baik, begitu 

pula dengan ketahanan pakai dan ketahanan thermalnya, serta mudah dalam 
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pemrosesan dan harganya yang cukup murah karena ketersediaan yang 

melimpah. 

2. Alluminium Alloys  

Alluminium Alloys sangat populer digunakan karena massanya yang 

ringan, hal ini membuat massa mesin juga berkurang secara signifikan. Tetapi, 

kelemahan utamanya adalah harganya yang lebih mahal dibanding grey cast 

iron. Alluminium Alloys memiliki machineabilityyang lebih baik daripada grey 

cast iron. Terdapat dua jenis alluminium alloys yang biasa digunakan dalam 

produksi blok silinder, yaitu 319 dan A356. 

Alluminium Alloys319 mengandung 85,8 – 91,5% alluminium, 5,5 – 6,5% 

silicon, 3 – 4% copper, 0,35% nikel, 0,25% titanium, 0,5% mangan 1% iron, 

0,2% magnesium, dan 1% zinc. Campuran logam ini baik untuk proses casting, 

tahan korosi, dan memiliki konduktivitas thermal yang baik. Dibawah proses 

heat treatment T5, diperoleh kekuatan dan kekakuan yang yang tinggi untuk 

blok silinder. 

Alluminium AlloysA356 mengandung 91,1 – 93% alluminium, 6,5 – 7,5% 

silicon, 0,25 – 0,45% magnesium, 0,2% copper, 0,2% titanium, 0,2% iron,, dan 

1% zinc. Meskipun memiliki sifat mekanis yang sama dengan 319. Jika A356 

berada dalam heat treatment T6 akan diperoleh kekuatan yang lebih tinggi 

daripada 319. Tetapi modulus elastisitasnya ( 72,4 GPa ) lebih rendah 

dibandingkan dengan 319 ( 74 GPa ). 

3. Compacted Graphite Cast Iron 

Compacted Graphite Cast Ironmemiliki tensile of strength dan modulus 

elastisitas yang lebih tingggi daripada grey cast iron. Hal ini karena compact 

graphite yang ditemukan dalam mikrostruktur dari CGI. Material ini memiliki 

tingkat penyerapan getaran yang sebaik gray cast ironnamun machineability-

nya rendah.  

2.1.4. Proses Pembuatan Blok Silinder 

Proses pembuatan blok silinder sama seperti proses pembuatan barang-

barang lain yang dibuat melalui sand casting. Pertama dibuat mold dari campuran 

pasir, silica clay, dan air. Mold tersebut adalah beberapa core yang disatukan 

melalui pemanasan dan kompresi. Untuk bentuk bagian dalam mold cavity yang 
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rumit, digunakan pattern yang biasanya terbuat dari kayu. Setelah mold siap 

digunakan, barulah logam bahan baku dilelehkan pada tungku khusus. Untuk 

melelehkan alluminium alloy dibutuhkan suhu hingga 948 derajat celcius. 

Temperatur yang digunakan berbeda beda untuk material berbeda. 

 

 

 

Gambar 2.5. Core dan Wooden Pattern 

Lelehan material tersebut kemudian dialirkan ke dalam mold untuk 

dibiarkan mengalami proses solidifikasi. Riser mengambil peranan yang sangat 

penting dalam proses ini sehingga peletakan dan ukurannya harus sangat 

diperhatikan. Riser yang baik harus memadat paling akhir setelah seluruh bagian 

molten material memadat. 

 

 

 

Gambar 2.6. Core yang telah disatukan dan siap digunakan 

Setelah memadat sempurna, mold dimasukkan kedalam mesin pemanas 

yang melelehkan rekatan silica clay sehingga pasir yang menjadi bahan dasar 
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mold terlepas. Pemansan ini juga meningkatkan kekuatan blok silinder. Namun, 

hasil yang diperoleh masih harus diproses kembali untuk menghilangkan sisa riser 

dan juga menghaluskan permukaan. Proses finishing ini akan menghasilkan blok 

silinder yang siap digunakan untuk proses perakitan mesin selanjutnya.  

 

 

 

Gambar 2.7. Blok Silinder Hasil Sand Casting 

(Irvan Zulkarnain, Academia.edu) 

 

2.2. Perangkat Lunak Desain  

CATIA (Computer Aided Three-dimensional Interactive Application) 

merupakan sebuah perangkat lunak untuk membantu proses desain, rekayasa, dan 

manufaktur. Perangkat lunak yang diusung IBM ini umumnya dikategorikan 

sebagai Computer Aided Design (CAD), Computer Aided Engineering (CAE), 

dan Computer Aided Manufacturing (CAM). Dengan CATIA, proses-proses 

pemodelan seluruhnya dilakukan secara digital sehingga tidak diperlukan lagi 

gambar manual ataupun model fisik. Misalnya assembly mobil atau pesawat 

terbang sepenuhnya dapat dilakukan di layar komputer, bahkan sebelum 

produknya jadi. 

Sebagai perbandingan, di waktu yang lalu, desain sketsa produk dibuat 

menggunakan komputer Macintosh dan dimensinya dibuat dengan Adobe 

Illustrator, sehingga proses desainnya memakan waktu yang cukup lama, bahkan 

berbulan-bulan. Selanjutnya, proses analisis terhadap kekuatan dan kelayakan 
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produk yang dibuat juga dilakukan secara digital sehingga dapat mengurangi 

proses trial dan error. 

Proses manufaktur juga diprogram dalam CATIA sehingga verifikasi dan 

validasi proses manufaktur dapat dilakukan secara offline sehingga tidak 

mengganggu proses produksi dan mengurangi reject. Pada mulanya CATIA 

dikembangkan oleh Dassault Systemes untuk keperluan Dassault Aviation. Dan 

baru sejak tahun 1981, CATIA digunakan secara komersial. 

Kemudian pada 1982, CADAM digabungkan dengan CATIA dan 

dipasarkan oleh IBM. CATIA V5 yang baru saja merilis fitur terbarunya dan 

mendukung prosesor 64 bit, memang menjadi andalan industri di dunia. 

Setidaknya 80 ribu perusahaan di 80 negara menggunakannya. 

Penggunaan di industri otomotif mencapai 33 persen, aerospace (16 

persen), alat elektronik dan konsumen (13 persen), pabrikasi dan assembly (34 

persen), juga pabrik dan kapal (4 persen). 

 

 

 

Gambar 2.8. Contoh Pemodelan Menggunakan CATIA 

Secara teknis, CATIA sangat mudah digunakan dan memiliki aplikasi 

yang lengkap dan lebih dari 140 modul untuk berbagai kebutuhan indutri. Untuk 

mengoperasikan perangkat lunak ini tidak perlu ahli khusus. Yang dibutuhkan 
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tetap saja para ahli industri masing-masing dalam produk mereka. (Mhd. Daud 

Pinem, S.T, 2009 : 1-2) 

 

2.3. Metode Elemen Hingga  

 Metode elemen hingga berasal dari bidang analisis struktural dan 

secaraluas dikembangkan dan dieksploitasi di industri dirgantara selama tahun 50-

an dan 60-an. metode-metode semacam itu dengan kuat ditetapkan dalam teknik 

sipil dan aeronautika, seperti yang disaksikan oleh penulis beberapa buku tentang 

masalah ini, seperti Zienkiewicz (1971), Desai dan Abel (1972) dan Nath (1974). 

Metode elemen hingga juga banyak digunakan oleh insinyur mekanik, terutama 

untuk analisis tegangan pada komponen padat. keberhasilan mereka telah 

sedemikian rupa sehingga metode eksperimental yang melibatkan pelapisan getas, 

pengukur regangan atau efek fotoelastik sampai batas tertentu sudah usang. 

Masalah dalam mekanika fluida dan perpindahan panas, bagaimanapun, jauh lebih 

jarang dipecahkan dengan metode elemen hingga. Salah satu alasan yang mungkin 

untuk ini adalah bahwa masalah-masalah seperti itu dipersulit tidak begitu banyak 

oleh kompleksitas geometris seperti oleh sifat fisik diproses yang terlibat. 

misalnya, sejauh ini perhatian yang relatif kecil telah diberikan pada solusi elemen 

hingga masalah di mana konveksi termal penting. 

(Roger T. Fenner : 1996) 

  Metode elemen hingga adalah metode numerik yang digunakan untuk 

memecahkan permasalahan dalam bidang rekayasa ataupun bidang fisik lainnya. 

Permasalahan-permasalahan dalam bidang rekayasa yang dapat dipecahkan 

dengan metode ini adalah meliputi analisa struktur, analisa tegangan, perpindahan 

panas dan masa, serta medan elektromagnetik. 

 Permasalahan-permasalahan yang melibatkan bentuk geometri, kondisi 

pembebanan dan sifat mekanik material yang komplek tidak mungkin untuk 

dipecahkan dengan menggunakan persamaan atau rumus matematis yang biasanya 

disebut dengan penyelesaian analitis. Penyelesaian analitis ini umumnya 

memerlukan penyelesaian persamaan diferensial parsial. Oleh karena itu, metode 

numerik seperti metode elemen hingga adalah metode yang banyak digunakan 

untuk memecahkan permasalahan-permasalahan yang komplek tersebut. Hasil 
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yang diperoleh dengan menggunakan metode elemen hingga ini adalah berupa 

harga pendekatan dari sejumlah titik atau node pada kontinum bodi. Maka dalam 

pemodelan di dalam metode elemen hingga, suatu bodi dibagi menjadi beberapa 

nodi atau unit yang lebih kecil yang disebut dengan elemen, yang mana elemen-

elemen tersebut saling berhubungan dengan elemen lain pada titik-titik simpul 

elemen atau dikenal dengan node. Proses pembagian ini disebut dengan 

diskritisasi. (Dr. Eng. Moch. Agus Choiron, dkk : 2014) 

 Teknik umum dan terminologi analisis elemen hingga akan diperkenalkan 

dengan mengacu pada Gambar 2.9. Angka tersebut menggambarkan volume 

beberapa materi atau bahan yang diketahui memiliki sifat fisik. Volume mewakili 

domain masalah nilai batas yang harus dipecahkan. Untuk kesederhanaan, pada 

titik ini, kami menganggap kasus dua dimensi dengan variabel bidang tunggal (x, 

y) menjadi ditentukan pada setiap titik P (x, y) sedemikian sehingga diketahui 

persamaan yang mengatur (atau persamaan) puas tepat pada setiap titik seperti itu.  

 

 

 

Gambar 2.9. (a) Domain umum dua dimensi variabel lapangan (x, y). 

(b) Elemen hingga tiga simpul didefinisikan dalam domain. (c) Tambahan 

elemen yang menunjukkan mesh elemen hingga parsial domain. 

 Perhatikan bahwa ini menyiratkan secara tepat solusi matematis diperoleh; 

yaitu, solusinya adalah aljabar bentuk tertutup ekspresi dari variabel independen. 

Dalam masalah praktis, domain mungkin menjadi kompleks secara geometris 

seperti, sering, persamaan yang mengatur dan kemungkinan untuk mendapatkan 
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solusi bentuk tertutup yang tepat sangat rendah. Karenanya, perkiraan solusi 

berdasarkan teknik numerik dan komputasi digital adalah yang paling sering 

diperoleh dalam analisis teknik dari masalah kompleks.  

 Metode elemen hingga adalah teknik yang ampuh untuk mendapatkan 

solusi perkiraan dengan akurasi yang baik. Elemen kecil segitiga yang 

membungkus subdomain berukuran terbatas dari area tersebut, bunga ditunjukkan 

pada Gambar 2.9b. Bahwa elemen ini bukan elemen diferensial ukuran dx × dy 

yang membuat elemen ini terbatas. Seperti kita memperlakukan contoh ini sebagai 

masalah dua dimensi, diasumsikan bahwa ketebalan dalam arah z adalah konstan 

dan z ketergantungan tidak ditunjukkan dalam persamaan diferensial. Simpul dari 

elemen segitiga diberi nomor untuk menunjukkan bahwa titik-titik ini adalah 

node. Sebuah simpul adalah titik spesifik dalam elemen hingga di mana nilai 

variabel lapangan harus dihitung secara eksplisit. Node eksterior terletak di batas 

dari elemen hingga dan dapat digunakan untuk menghubungkan elemen ke finite 

yang berdekatan elemen. Node yang tidak terletak pada batas elemen adalah node 

interior dan tidak dapat dihubungkan ke elemen lain. Elemen segitiga pada 

Gambar 2.9b hanya memiliki node eksterior. Jika nilai-nilai variabel bidang 

dihitung hanya pada node, bagaimana juga nilainya diperoleh pada titik lain dalam 

elemen hingga? Jawabannya berisi inti dari metode elemen hingga: Nilai-nilai 

variabel lapangan dihitung pada node digunakan untuk memperkirakan nilai pada 

titik non node (yaitu, dalam elemen interior) dengan interpolasi nilai node. Untuk 

contoh segitiga tiga simpul, semua node eksterior dan, pada titik lain di dalam 

elemen, bidang variabel dijelaskan oleh perkiraan hubungan 

  (   )    (   ) 
 
   (   ) 

 
   (   ) 

 
   (2.1) 

di mana   ,   , dan   adalah nilai-nilai variabel lapangan di node dan   , 

  ,dan   adalah fungsi interpolasi, juga dikenal sebagai fungsi bentuk atau 

blendingfungsi. Dalam pendekatan elemen hingga, nilai nodal dari variabel 

fielddiperlakukan sebagai konstanta yang tidak diketahui yang harus ditentukan. 

Interpolasifungsi paling sering berupa polinomial dari variabel 

independen,diturunkan untuk memenuhi kondisi tertentu yang diperlukan di node. 

Poin utama yang harus dibuat di sini adalahbahwa fungsi interpolasi sudah 
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ditentukan sebelumnya, diketahui fungsi independen variabel dan fungsi-fungsi 

ini menggambarkan variasi variabel bidangdalam elemen hingga. 

 Elemen segitiga yang dijelaskan oleh Persamaan 2.1 dikatakan memiliki 3 

derajatkebebasan, karena tiga nilai nodal dari variabel lapangan diminta untuk 

dijelaskanvariabel bidang di elemen mana saja. Ini akan menjadi kasus jika 

bidangvariabel mewakili bidang skalar, seperti suhu dalam masalah perpindahan 

panas. Jika domain pada Gambar 2.9 mewakili tubuh yang tipis dan padat yang 

dikenakanplane stress, variabel lapangan menjadi vektor perpindahan dannilai dari 

dua komponen harus dihitung pada setiap node. Dalam kasus terakhir,elemen 

segitiga tiga simpul memiliki 6 derajat kebebasan. Secara umum, jumlahderajat 

kebebasan yang terkait dengan elemen hingga sama dengan produkdari jumlah 

node dan jumlah nilai dari variabel field (dan mungkinturunannya) yang harus 

dihitung pada setiap node.Bagaimana pendekatan berbasis elemen ini bekerja di 

seluruh domain yang diminati?Seperti yang digambarkan pada Gambar 2.9c, 

setiap elemen terhubung pada bagian luarnyanode ke elemen lain. Persamaan 

elemen hingga dirumuskan sedemikian rupa sehingga, pada koneksi nodal, nilai 

variabel bidang pada koneksi apa pun adalahsama untuk setiap elemen yang 

terhubung ke node. Dengan demikian, kontinuitas variabel lapangan di node 

dipastikan. Bahkan, formulasi elemen hingga adalah sedemikian rupa kontinuitas 

variabel lapangan melintasi batas antar elemen juga dipastikan. Fitur ini 

menghindari kemungkinan kesenjangan atau kekosongan fisik yang tidak dapat 

diterima dalam domain. Dalam masalah struktural, kesenjangan seperti itu akan 

mewakili fisik pemisahan material. Dalam transfer panas, "celah" akan terwujud 

bentuk suhu yang berbeda pada titik fisik yang sama. Meskipun kontinuitas 

variabel lapangan dari elemen ke elemen melekat untuk formulasi elemen hingga, 

kontinuitas antar gradien (mis., turunan) dari variabel lapangan umumnya tidak 

ada. Ini adalah pengamatan kritis. Dalam kebanyakan kasus, turunan seperti itu 

lebih menarik daripada variabel lapangan nilai-nilai. Sebagai contoh, dalam 

masalah struktural, variabel lapangan adalah perpindahan tetapi minat yang 

sebenarnya lebih sering pada ketegangan dan stres. Sebagai regangan 

didefinisikan dalam halturunan pertama dari komponen perpindahan, regangan 

tidak kontinu melintasi elemenbatas-batas. Namun, besarnya diskontinuitas 
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turunan dapatdigunakan untuk menilai akurasi solusi dan konvergensi sebagai 

jumlah elemenmeningkat. (David V. Hutton : 2004) 

 

2.4. Metode Numerik 

Metode numerik adalah teknik untuk menyelesaikan permasalahan-

permasalahanyang diformulasikan secara matematis dengan menggunakan operasi 

hitungan(arithmatic) yaitu operasi tambah, kurang, kali, dan bagi. 

Alasan pemakaian metode numerik adalah banyak permasalahan matematis 

tidakdapat diselesaikan dengan metode analitik. Jika terdapat penyelesaian secara 

analitik,mungkin proses penyelesaiannya sangat rumit, sehingga tidak effisien. 

2.4.1. Persamaan Linear 

2.4.1.1 Solusi Sistem Persamaan Linier 

Kita telah mengenal penyelesaian sistem persamaan linier, seperti 

eliminasi Gauss,Gauss-Jordan, atau metode balikan matriks. Metode-metode 

tersebut termasuk metodelangsung. Pada bab ini akan dibahas metode tak 

langsung atau disebut juga metodeiterasi. 

Metode iterasi yang akan dibahas adalah metode iterasi Jacobi, dan Gauss-Seidel. 

Padametode Jacobi, nilai hampiran dikoreksi secara serentak. Artinya nilai 

hampiranmengacu pada nilai hampiran sebelumnya. Sedangkan pada metode 

Gauss-Seidel, nilaihampiran dihitung berdasarkan nilai hampiran terbaru atau 

terakhir.Misal terdapat sistem persamaan linier, 
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Jika sistem persamaan linier tersebut ditulis dalam bentuk matriks, maka 
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Sehingga               (2.4) 

Hal yang perlu diperhatikan adalah seluruh elemen A ≠0. Jika ada elemen A = 0, 

makalakukan pertukaran baris.Matriks A dapat diuraikan menjadi 
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Maka matriks A dapat ditulis dalam bentuk             (2.5) 

Subtitusi persamaan (2.5) ke (2.4) didapat, (     )       (2.6) 

 

 

 



17 

 

2.4.2. Solusi Persamaan dan Sistem Persamaan Non-Linear 

2.4.2.1. Metode Penyelesaian Persamaan Non-Linier 

Secara garis besar, metode yang digunakan untuk menentukan akar-akar 

atau penyelesaian persamaan non-linier dikelompokkan menjadi metode, yaitu 

metode tertutup dan terbuka 

A. Metode Tertutup atau Metode Pengurung (Bracketing Method) 

Metode Tertutup disebut juga Metode Pengurung (bracketingmethod) 

adalah metode yang mencari akar atau akar-akar di dalam selang [a, b]. 

Metode tertutup terdiri dari beberapa jenis, yaitu metode grafis, metode bagi 

dua (bisection), dan metode posisi salah (regula falsi). 

 Metode Grafis 

Metode grafis adalah metode yang sederhana untuk memperoleh 

hampiran nilai  untuk fungsi  ( )      atau titik di mana grafik fungsi 

memotong sb. x. Misal terdapat fungsi  ( )       –     –     –   . Lalu kita 

gambarkan grafik fungsi tersebut pada koordinat Kartesius (lihat gambar 

berikut). 

 

 

 

Gambar. 2.10. Grafik fungsi  ( )             
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Dari gambar tersebut kita dapat memperkirakan nilai dari akar- akar 

persamaan, yaitu     (–    )      (–    ) , dan      (   ). 

Kekurangan metode grafik adalah hasil yang didapat merupakan hampiran 

kasar. Dengan kata lain galat (error) yang dihasilkan lebih besar jika 

dibandingkan dengan metode lainnya. Sedangkan kelebihannya adalah dapat 

memperlihatkan sifat-sifat fungsi. 

 

 

 

Gambar 2.11. Sifat-sifat fungsi 
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Perhatikan Gambar 2.11. (a), (b), (c), dan (d). Misal  ( ) adalah fungsi 

yangkontinu dan tidak menyinggung sumbu  pada            Jika   (  ) dan 

  (  )mempunyai tanda yang sama;   dan   atau – dan – , maka jumlah 

titikpotong  ( ) dengan sumbu   berjumlah genap (0, 2, 4, …). Lihat 

gambar 2.11. (a),(b), dan (c). 

Jika  (   ) dan  (  ) mempunyai tanda yang berbeda; + dan – atau – dan 

+,maka jumlah titik potong  ( ) dengan sumbu   berjumlah ganjil (1, 3, 5, 

…).Lihat gambar 2.11. (d) dan (e). 

 Metode Bagi Dua (Bisection) 

Metode bagi dua disebut juga pemotongan biner (binary chopping), 

metode pembagian dua (interval halving), atau metode Bolzano adalah 

metode suatu jenis pencarian nilai hampiran secara inkremental dengan cara 

membagi interval menjadi dua bagian. Prinsip metode bagi dua adalah 

mengurung akar fungsi pada interval [xi, xf]. Selanjutnya interval tersebut 

terus menerus dibagi dua hingga sekecil mungkin, sehingga nilai hampiran 

yang dicari dapat ditentukan dengan tingkat akurasi tertentu. 

Algoritmanya adalah sebagai berikut: 

1. Taksir batas bawah (  ) dan batas atas (  ) dengan 

syarat (  )  (  )    

2. Hitung nilai hampiran akar dengan rumus,     
       

 
 

3. Jika   (  )   (  )       maka          Lanjutkan ke langkah 4 

Jika   (  )   (  )     , maka        . Lanjutkan ke langkah 4 

Jika   (  )   (  )     , maka akar =   . Stop. 

4. Hitung nilai hampiran akar yang baru dengan rumus pada langkah 

2.Ingat, nilai xi dan/atau xf adalah nilai baru yang didapat dari 

langkah 3. 

5. Jika nilai akar telah mencapai tingkat akurasi yang telah ditentukan, 

stopkomputasi. Jika tidak kembali ke langkah 3. 
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Gambar. 2.12. Grafik dari Algoritma Metode Bagi Dua 

Nilai    dicari dengan rumus  

   
     

 
       (2.7) 

Jumlah leleran atau iterasi Runtuk menjamin nilai solusi hampiran memiliki 

galat kurang dari batas toleransi kesalahan    adalah 

  
  |     |    

   
      (2.8) 

 Metode Regula Falsi (False Position Methode) 

 Istilah Regula Falsi - berasal dari bahasa latin - atau Metode Posisi 

Palsu (False Posisition Method) termasuk metode tertutup atau metode 

pengurung. 

Perbedaannya dengan metode bagi dua adalah pada cara menentukan nilai 

akar. Persamaannya adalah nilai akar yang dicari dikurung oleh interval 

tertutup         . 

Pada metode posisi palsu digunakan garis lurus yang menghubungkan titik 

koordinat (     (  )) dan (     (  ))  Perpotongan garis yang dibuat 

dengan sumbu x menghasilkan taksiran nilai akar yang dicari. 

Algoritmanya adalah sebagai berikut: 

1. Taksir batas bawah (  ) dan batas atas (   ) dengan 

syarat    )    (  )      

2. Hitung nilai hampiran akar dengan rumus,      (      )   
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3. Jika   (  )   (  )     , maka          Lanjutkan ke langkah 4 

Jika   (  )   (  )     , maka          Lanjutkan ke langkah 4 

Jika   (  )   (  )     , maka akar =  . Stop. 

4. Hitung nilai hampiran akar yang baru dengan rumus pada langkah 

2.Ingat, nilai xi dan/atau xf adalah nilai baru yang didapat dari 

langkah 3. 

5. Jika nilai akar telah mencapai tingkat akurasi yang telah ditentukan, 

stopkomputasi. Jika tidak kembali ke langkah 3. 

 

 

 

Gambar. 2.13. Grafik dari Metode Regula Falsi 

Dari Gambar. 2.13 didapat  
 (  )  (  )

     
 

 (  )

     
 

Sehingga       
 (  )(     )

 (  )  (  )
    (2.9) 

B. Metode Terbuka 

 Metode terbuka adalah metode yang menggunakan satu, atau dua 

tebakan awalyang tidak perlu mengurung akar. Metode terbuka terdiri dari 

beberapa jenis,yaitu metode Iterasi Titik Tetap, metode Newton-Raphson, 

dan metode Secant. 
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 Metode Iterasi Titik Tetap 

Metode ini juga disebut metode sederhana, langsung, atau metode 

sulihberuntun.Jika terdapat suatu fungsi f (x) dan kita akan mencari akar 

atau akar-akar darifungsi tersebut, berarti kita harus menetapkan  ( )    

sedemikian sehingga     ( )  

Algoritma dari metode iterasi titik tetap adalah: 

1. Bentuk fungsi f (x) menjadi  ( )    

2. Dari no. 1 susun menjadi bentuk    ( ) 

3. Lakukan tebakan awal    

4. Hitung      dengan menggunakan rumus       (  ) 

 

 

 

Gambar. 2.14. Algoritma dari Metode Iterasi Titik Tetap 

 Metode Newton-Raphson 

Metode ini juga termasuk metode terbuka seperti halnya metode iterasi 

titik tetap.Rumus yang digunakan pada metode Newton-Raphson dapat 

diturunkan secara grafis maupun perluasan deret Taylor. 
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Gambar. 2.15. Iterasi Newton-Raphson Secara Grafis 

   (  )       
 (  )

      
    (2.10) 

 Sehingga Iterasi Newton-Raphson didapat  

           
 (  )

  (  )
     (2.11) 

 Penurunan rumus iterasi Newton-Raphson dengan perluasan deret 

Taylor. 

Perluasan deret Taylor dapat dinyatakan sebagai, 

  (    )   (  )(       )  
   ( )

 
(       )

2    (2.12) 

Sebagai langkah untuk menghitung solusi hampiran, kita dapat 

mengabaikansuku-suku setelah turunan pertama. Sehingga deret Taylor 

dapat ditulismenjadi, 

 (    )   (  )    (  )(       )     (2.13) 

Pada saat kurva memotong sumbu  , maka  (    )    

Jadi    (  )    (  )(       ) 

Atau         
 (  )

  (  )
   ( = Persamaan 2.11 ) 

 Metode Secant  

Metode iterasi Secant merupakan metode yang dihasilkan dari 

modifikasi darimetode Newton-Raphson dengan cara mengganti   ( ) pada 

persamaan (4.12)dengan bentuk yang mendekati seperti pada gambar 

berikut.Dari grafik dapat dilihat bahwa metode secant membutuhkan dua 

buah tebakanawal, seperti halnya pada metode bagi dua (bisection) atau 
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regula falsi. Bedanyadua tebakan awal pada metode secant tidak perlu 

mengurung solusi. 

 

 

 

Gambar. 2.16. Iterasi Metode Secant Secara Grafis 

2.4.2.2. Sistem Persamaan Non-Linear 

Metode penyelesian sistem persamaan non-linier terdiri dari metode 

iterasi titik tetapdan metode Newton-Raphson. Bentuk umum sistem persamaan 

non-linier adalahsebagai berikut. 











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       (2.14) 

Solusi sistem persamaan menghasilkan nilai x1, x2, …, xn yang memenuhi 

seluruhpersamaan. 

 Metode Iterasi Titik Tetap 

Prosedur iterasi titik tetap untuk sistem persamaan linier yang terdiri 

dari misalnya, 3 persamaan adalah 


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r
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     (2.15) 



25 

 

Metode iterasi titik tetap seperti pada persamaan (2.34) disebut metode 

Jacobi. Untuk meningkatkan kecepatan konvergensi, maka nilai hampiran 

variabel yang didapat langsung digunakan untuk mentukan nilai hampiran 

variabel selanjutnya. 

Sehingga persamaan (2.34) menjadi 















),1,1(1

),,1(1

),,(1

3

2

1

rrrr

rrrr

rrrr

zyxgz

zyxgy

zyxgx

       (2.16) 

Metode iterasi titik tetap seperti pada persamaan (2.34) disebut metode 

seidel. 

2.4.3. Persamaan Differensial Biasa 

2.4.3.1. Jenis-jenis persamaan differensial 

Persamaan differensial dibedakan menurut orde, derajad, linieritas, dan 

jumlah variable bebas seperti yang ditunjukkan pada tabel2.1. 

Tabel 2.1. Jenis-jenis Persamaan Differensial 

No Persamaan Differensial Orde Derajat Linier / Non-Linier Biasa / Parsial 

1 
  

  
   1 1 Linier Biasa 

2 (
   

   )

 

    3 2 Non-Linier Biasa 

3 (
   

   )

 

  (
  

  
)
 

      3 2 Non-Linier Biasa 

4             2 1 Non-Linier Biasa 

5 
   

    
   

    
   

     (     ) 2 1 Linier Parsial 

6 
  

  
  

   

  
 3 2 Linier Parsial 

7              3 2 Non-Linier Biasa 

 

 

Solusi numerik yang akan dibahas hanya mencakup Persamaan Differensial Biasa 

(PDB) Orde Pertama. 
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2.4.3.2. Metode Penyelesaian Persamaan Differensial Biasa. 

Metode-metode yang biasa digunakan untuk menentukan 

solusi PDB orde pertama adalah: 

- Metode Euler 

- Metode Heun 

- Metode Deret Taylor 

- Metode Runge-Kutta 

- Metode Predictor-Corrector 

A. Metode Euler 

 Metode Euler dibedakan menjadi 3 bentuk, yaitu: 

 - Metode Euler Maju (Forward) 

 - Metode Euler Mundur (Backward) 

 - Metode Euler yang Dimodifikasi (Modified) 

 Metode Euler Langkah Maju (Forward) 

Tinjau Persaman Differensial Biasa Orde Pertama berikut. 

     (   );  (   )          (2.17) 

Tentukan titik n sebagai titik dasar (Gambar 2.23) dan susun aproksimasi 

beda 

hingga (finite difference) dari persamaan (2.17). 

 

 

 

Gambar. 2.17. Titik n Sebagai Titik Dasar 

Misal )(
rr

xyy   adalah nilai hampiran y di titik xr , dan 
rr

xxh 
1

 

Jika )(
1r

xy  diuraikan disekitar 
n

x  pada deret Taylor, maka didapat 
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Dua suku pertama pada persamaan (2.53) adalah 

  )('
!1

)()(
1

1 r

rr

rr
xy
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xyx







      (2.19) 

Subtitusi persamaan (2.20) dan (2.21) ke (2.23) didapat 

  
rrrrrr

hfyyxhxyxy 


),()()(
1

     (2.20) 



27 

 

 Metode Euler Mundur (Forward) 

Tentukan titik r +1 sebagai titik dasar (Gambar 2.18) dan susun 

aproksimasibeda hingga (finite difference) dari persamaan (2.17). 

 

 

 

Gambar. 2.18. Titik  r+1Sebagai Titik Dasar 

Jika  (     ) diuraikan di sekitar    pada deret Taylor, maka didapat 
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Dua suku pertama pada persamaan (2.21) 
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Substitusi persamaan (2.17) dan (2.18) ke (2.19) didapat 

 
1111

),()()(
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hfyyxhfxyxy       (2.23) 

 Metode Heun 

Metode Heun (disebut juga metode Prediktor-Korektor Euler yang 

dimodifikasi).Solusi dari metode ini terdiri dari dua langkah, yaitu Prediktor 

dan Korektor. 

 ),(
1 rrrrr

p

r
yxhyhfyy 


   (2.24) 
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2

1

111

p

rrrrrrr

c

r
yxfyxhfyhfyy


     (2.25) 

 Metode Deret Taylor 

Deret Taylor dapat digunakan untuk mengevaluasi suatu fungsi jika 

turunan dan nilai turunan pada suatu titik tertentu diketahui. 

Misal terdapat PDB tak-linier, 

 ),(' yxfy       ;    
00

)( yxy      (2.26) 

 

Misal       (    ) ,             adalah hampiran nilai y di      

disekitar    sebagai berikut. 
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Atau 
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(Ir. Sudiadi, M.M.A.E. dan Ir.Rizani Teguh, MT, 2015) 

 

2.5. Perangkat Lunak Simulasi dan Pengujian 

 ANSYS Workbench adalah salah satu perangkat lunak berbasiskan 

metode elemen hingga yang dipakai untuk menganalisa masalah-masalah 

rekayasa (engineering). ANSYS Workbench menyediakan fasilitas untuk 

berinteraksi antar solvers famili ANSYS. ANSYS Workbench juga dapat 

berintegrasi dengan perangkat lunak CAD sehingga memudahkan pengguna 

dalam membangun model geometri dengan berbagai perangkat lunak CAD. 

Beberapa perangkat tersesbut adalah CATIA dan SOLIDWORK. ANSYS 

dapat berjalan di platform Windows dan Linux. (Mechanical Brother, 

WordPress). 

 ANSYS adalah program komputer elemen hingga tujuan umum 

komprehensif yang berisi lebih dari 100.000 baris kode. Ansys mampu melakukan 

analisis statis, dinamis, perpindahan panas, aliran fluida, dan elektromagnetisme. 

Ansys telah menjadi program analisis elemen hingga terkemuka selama lebih dari 

20 tahun. versi Ansys saat ini memiliki tampilan yang sama sekali baru, dengan 

beberapa jendela yang menggabungkan Graphical User Interface (GUI), menu 

pull-down, kotak dialog, dan bilah alat. Hari ini, anda akan menemukan Ansys 

digunakan di banyak bidang teknik, termasuk aerospace, elektronik otomotif, dan 

nuklir. untuk menggunakan Ansys atau program komputer FEA (Finite Element 

Analysis) "kalengan" lainnya secara cerdas, sangat penting bagi seseorang untuk 
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sepenuhnya memahami konsep dasar yang mendasari dan keterbatasan metode 

elemen hingga. 

 Ansys adalah alat teknik yang sangat kuat dan mengesankan yang dapat 

digunakan untuk menyelesaikan berbagai masalah. Namun, pengguna tanpa 

pemahaman dasar tentang metode elemen hingga akan mendapati dirinya dalam 

kesulitan yang sama dengan teknisi komputer dengan akses ke banyak instrumen 

dan alat yang mengesankan, tetapi siapa yang tidak dapat memperbaiki komputer 

karena ia tidak memahami bagian dalam cara kerja komputer. 

(Saeed Moaveni : 1999) 

 

 

 

Gambar 2.19. Contoh Hasil Pengujian Menggunakan ANSYS 

2.6. Pegujian Mekanik 

2.6.1. Uji Tarik 

 Pada uji tarik, kedua ujung benda uji dijepit, salah satu ujung dihubungkan 

dengan perangkat pengukur beban dari mesin uji dan ujung lainnya dihubungkan 

ke perangkat peregang. Regangan diterapkan melalui kepala-silang yang 

digerakkan motor dan elongasi benda uji ditunjukkan dengan pergerakan relatif 

dari benda uji. Beban yang diperlukan untuk menghasilkan regangan tersebut 

ditentukan dari defleksi elastis suatu balok atau proving ring, yang diukur dengan 

menggunakan metode hirolik, optik, atau elektromekanik. Cara terakhir ini 

(dimana kemungkinan terjadi perubahan tahanan pada pengukur regangan yang 

ditempelkan pada balok) dengan sendirinya, mudah disesuaikan dengan sistem 

untuk mencatat otografik dari kurva beban-elongasi. 
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 Kurva beban-elongasi untuk baja karbon sedang polikristalin dan tembaga 

ditampilkan pada gambar 2.8a dan 2.8b. Tegangan (beban per satuan luas, P/A) 

terhadap regangan (perubahan panjang per satuan panjang, dl/l) dapat diperoleh 

setelah mengetahui dimensi benda uji. Pada tegangan rendah deformasi bersifat 

elastis, mampu balik (reversible), dan mengikuti hukum Hooke, yaitu tegangan 

berbanding lurus dengan regangan. Konstanta proporsional yang mengaitkan 

tegangan dengan regangan disebut modulus elastisitas dan dapat berupa (a) 

modulus elastisitas atau modulus Young, E, (b) kekakuan atau modulus geser, µ, 

atau (c) modulus curah, K, bergantung apakah regangan bersifat tarik, geser, atau 

kompresi hidrostatik. Modulus Young, modulus curah, modulus geser, dan rasio 

Poisson υ, yaitu rasio kontraksi lateral terhadap regangan longitudinal untuk 

tegangan tarik uniaksial, mempunyai hubungan sebagai berikut : 








 
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     (2.29) 

 

 Umumnya, limit elastis bukan merupakan definisi tegangan yang jelas, 

tetapi pada besi tidak murni dan baja karbon rendah, titik awal terjadinya 

deformasi plastis ditandai dengan penurunan beban secara tiba-tiba yang 

menunjukkan adanya titik luluh atas dan titik luluh bawah. Perilaku luluh ini 

merupakan karakteristik berbagai jenis logam, khususnya yang memiliki struktur 

bcc dan mengandung sejumlah kecil elemen larut. Untuk material yang tidak 

memiliki titik luluh yang jelas, berlaku definisi konvensional mengenai titik awal 

deformasi plastis, yaitu tegangan uji 0,1%. Disini ditarik garis sejajajr dengan 

bagian elastis kurva tegangan-regangan dari titik dengan regangan 0,1%. 
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Gambar 2.20. Kurva tegangan-perpanjangan untuk (a) besi tidak murni, (b) 

tembaga, (c) transisi ulet-getas pada baja sedang 

 Untuk tujuan pengendalian, uji tarik memberikan informasi yang berharga 

mengenai kekuatan tarik (TS = beban maksimum/luas penampang awal) dan 

keuletan (persen reduksi penampang atau persen perpanjangan) material. Apabila 

dimanfaatkan sebagai teknik penelitian, diperlukan bentuk dan rincian kurva yang 

teliti. Namun demikian, perubahan tegangan luluh dan tegangan putus akibat 

variasi temperatur, penambahan paduan, dan ukuran butir jauh lebih penting. 

 Bertambahnya tegangan mulai dari luluh awal hingga TS (kuat tarik 

maksimum) menunjukkan bahwa benda uji mengalami pengerasan akibat 

deformasi (terjadi pengerasan-kerja). Pada peregangan malampaui TS, pengerasan 

kerja masih berlanjut, tetapi lajunya terlampau kecil untuk mengimbangi reduksi 

luas penampang benda uji. Deformasi berubah menjadi tidak stabil, sehingga 

daerah tertentu pada panjang ukur benda uji mengalami regangan melebihi daerah 

lain. Tetapi pengerasan yang terjadi tidak memadai untuk meningkatkan tegangan 

sedemikian sehingga deformasi dapat berlanjut didaerah ini dan melebihi 

tegangan untuk menimbulkan regangan di tempat lain. Penciutan terjadi didaerah 

panjang ukur, dan deformasi terpusat didaerah ini hingga terjadi patahan. Dengan 

kondisi ini, penyusutan luas penampang (A0 – A1)/A0 dimana A0 dan A1 adalah 

luas penampang awal dan luas penampang akhir didaerah penciutan, merupakan 

petunjuk mengenai regangan yang terlokalisir, dan menjadi indikator yang lebih 

baik dibandingkan regangan saat putus tehadap panjang ukur. 
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 Kurva tegangan-regangan sesungguhnya seringkali digambarkan untuk 

memperlihatkan perilaku pengerasan-kerja dan pergenangan pada regangan yang 

besar. Tegangan sesungguhnya, σ sama dengan beban P dibagi luas benda uji A 

pada tahap regangan tertentu. Regangan total sesungguhnya ketika terjadi 

deformasi dari panjang awal l0 hingga l1 adalah  )./ln()/(
01

0

1
llldl

l

l
   Kurva 

tegangan-regangan susungguhnya cocok dengan hubungan ludwig n
k 

dimana n adalah koefisien pengerasan kerja dengan nilai 5,01,0  dan k adalah 

koefisien kekuatan. Ketidakstabilan plastis, atau penciutan, terjadi apabila 

peningkatan regangan tidak menghasilkan penambahan beban pada spesimen, 

yaitu dP = 0, dan karena AP  , maka 0 dAAddP   mendefinisikan 

kondisi ketidakstabilan. Selama deformasi, volume spesimen dianggap konstan 

)0( dV dan dari persamaan : 

0)(  ldAAdllAddV  (2.30) 

Diperoleh 





d

l

dl

A

dAd


 (2.31) 
 

Jadi, penciutan terjadi pada regangan ketika kemiringan kurva tegangan-regangan 

sesungguhnya sama dengan tegangan sesungguhnya pada regangan tersebut, jadi 

 dd / . Sebaliknya karena 1
/




nn
nkddk   maka n  dan 

penciutan terjadi apabila regangan sesungguhnya sama dengan eksponen 

pengerasan regangan. Kondisi ketidakstabilan dapat pula dinyatakan dengan 

besaran konvensional (regangan nominal) sebagai 





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d
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 (2.32)

 

yang memungkinkan letak titik ketidakstabilan ditentukan dengan menggunakan 

konstruksi Considére (lihat Gambar 2.9), dengan memplot kurva tegangan 

sesungguhnya terhadap regangan nominal dan menggambar garis singgung kurva 

dari 1
n

  pada sumbu regangan. Titik potong adalah tegangan ketidakstabilan 

dan kekuatan tariknya adalah ).1/(
n

   
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 Spesimen tarik juga memberikan informasi mengenai jenis perpatahan 

yang terjadi. Biasanya logam polikristalin mengalami perpatahan transgranular 

(yaitu permukaan perpatahannya menembus butir) dan tipe perpatahan “cup and 

cone” sering dijumpai pada logam ulet, seperti tembaga. Pada tipe perpatahan ini, 

perpatahan benda uji dimulai di pusat daerah yang mengalami penciutan dan 

mula-mula tumbuh tegak lurus pada sumbu tarik. Dengan demikian terbentuk 

“cup”, akan tetapi mendekati permukaan luar, perpatahan berubah menjadi bentuk 

“cone” dan permukaan patahan membentuk sudut 45
o
 dengan sumbu tarik. Bila 

diperhatikan secara rinci, 

 

 

 

Gambar 2.21. Konstruksi Considére 

ternyata “cup” itu sendiri terdiri dari sejumlah permukaan tak beraturan yang 

membentuk sudut 45
o 

dengan sumbu tarik, sehingga patahan tampak berserabut 

(fibrous). Rengkah (cleavage) juga merupakan tipe perpatahan transgranular yang 

sering kali terjadi, khususnya pada material dengan struktur bcc apabila diuji pada 

temperatur rendah. Permukaan patahan mengikuti bidang kristal tertentu (yaitu 

bidang {1 0 0}), dan butir menampilkan faset besar yang mengkilap, tetapi 

permukaan juga terlihat granular dengan “garis sungai” yang memotong faset 

dimana terdapat bidang rengkah. Kadang-kadang terjadi perpatahan interkristalin, 

dan seringkali tidak diiringi deformasi yang berarti. Tipe perpatahan ini biasanya 

ditimbulkan oleh fasa presipitasi kedua yang getas disekitar batas butir, seperti 

yang mengandung bismut atau antimon. (Metalurgi Fisik Modern & Rekayasa 

Material, 2000 : 214-216) 

2.6.2 Uji Tekan 
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Uji tekan diperlukan untuk mengetahui kekuatan tekan suatu bahan. 

Peristiwa pembebanan tekan terjadi pada suatu bahan yang ada pada gilirannya 

perlu diketahui seberapa kekuatan tekan yang harus dipersiapkan atau mengetahui 

kekuatan tekan suatu bahan guna mengetahui batas wajar pembebanannya. 

Umumnya kekuatan tekan lebih tinggi daripada kekuatan tarik, sehingga 

desain cukup dengan menggunakan data kekuatan tarik, tetapi jika 

pembebanannya hanya tekan, lalu dipakai data kekuatan tarik bahan, maka dapat 

menghasilkan desain berdimensi yang berlebihan. 

Mesin Tarno Grocki juga dapat digunakan untuk uji tekan. Uji tekan 

mempunyai kemiripan dengan uji tarik. Spesimen uji tekan dapat berupa silinder 

atau segi empat. Perbandingan antara panjang dan diameter spesimen (L/d) 

menjadi pertimbangan penting. Pertimbangan L/d yang kecil untuk menghindari 

buckling, dan L/d yang kecil untuk menghindari pengaruh ujung spesimen (end 

effect). Untuk bahan ulat disukai L/d= 3, dan untuk bahan getas dapat dipilih L/d 

= 1,5 atau 2. Pemotongan spesimen uji tekan haruslah tegak lurus terhadap 

sumbu, ketidak lurusan mengakibatkan spesimen dapat mengguling saat ditekan. 

Teknik sederhana memeriksa spesimen adalah meletakkan bidang potong pada 

bidang datar, kemudian memutar sambil disejajarkan dengan penggaris tegak 

lurus yang dihimpitkan ke dinding silindernya, jarak yang tetap saat diputar 

menandakan spesimen sudah dipotong secara tegak lurus. 

Uji tekan untuk spesimen plastik PVC (Poly Vinyl Chloride) dan PE 

(Polietilen) menunjukkan sifat ulet dan sifat getas. Penekanan batang silindris 

PVC berdiameter 20 mm dan panjang 40 mm hingga lebih 30% panjang spesimen 

menunjukkan perubahan bentuk menggembung seperti barrel memerlukan gaya 

lebih dari 2 ton tanpa pecah menandakan PVC kuat dan ulet, sementara PE 

dengan ukuran yang sama dengan pemendekan sekitar 30% panjang spesimen 

telah menunjukkan kerapuhannya yang jelas menandakan bahan tersebut tidak 

kuat dan getas. 

Kekuatan tekan diperoleh dari:  

AF
c

/
 (2.33)

 

(Teknologi Bahan, 2016 : 68-69). 
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BAB 3 

METODOLOGI PENELITIAN 

 

 

3.1. Tempat dan Waktu 

3.1.1. Tempat 

 Adapun tempat dilakukannya studi analisis numerik pada struktur blok 

silinder dengan menggunakan software catia V5R19 serta menganalisa 

menggunakan software ansys 15.0 dilakukan dilaboratorium Teknik Mesin 

Universitas Muhammadiyah Sumatera Utara. 

3.1.2.  Waktu 

 Pengerjaan dan penyusunan tugas sarjana ini dilaksanakan 16 mei 2018 

dan dinyatakan selesai oleh dosen pembimbing pada tanggal 12 Januari 2019 

Tabel 3.1: Waktu Kegiatan 

No Kegiatan Mei Jun Jul Sep Okt Nov Des Jan 

1 Studi Literatur         

2 

Menentukan 3 

Desain Blok 

Silinder 
  

      

3 
Menggambar 

Spesimen 
  

      

4 

Mensimulasi 

Desain Blok 

Silinder 
  

      

5 
Menampilkan 

Gambar 
  

      

6 
Menentukan 

Metode Pengujian 
  

      

7 Simulasi Pengujian         

8 
Penyelesaian 

Skripsi 
  

      

 

 

 

 

 



36 

 

3.2.    Alat Penelitian  

  Adapun alat yang digunakan dalam studi numeric ini adalah : 

3.2.1.  Komputer 

 Spesifikasi Komputer yang digunakan dalam studi numeric ini adalah 

sebagai berikut : 

1. Processor  : Xeon CPU-E3-1246-V3@3.5GHz 

2. Ram   : 8 GB 

3. Operation System : Product ID ( Windows 7 Profesional 64 bit ) 

4. Display  : NVIDIA Quardo K620 

5. Harddisk  : 1 TB 

6. DVD Rom  : Lenovo 

7. Monitor  : Lenovo L1 2054, 19.5 Inch Resolusi 1440 x 900 

8. Keyboard  : Lenovo 

9. Mouse   : Lenovo 

3.2.2.   Software Catia 

 Software catia yang sudah terinstal pada komputer adalah catia V5R19 64 

bit yang didalamnya terdapat sketch gambar 3D. Dengan persyaratan system pada 

computer adalah sebagai berikut : 

1. Processor : Xeon CPU-E3-1246-V3@3.5GHz 

2. RAM  : 8 GB 

3. Disk Space : 5 GB or more 

3.2.3. Software Ansys 

 Software ansys yang sudah terinstal pada komputer adalah ansyss 2015 

yang didalamnya terdapat mechanical APDL 2015 dan workbench 2015. Dengan 

persyaratan system pada computer adalah sebagai berikut : 

1. Processor : Xeon CPU-E3-1246-V3@3.5GHz 

2. RAM  : 8 GB 

3. Disk Space : 15 GB or more 

 

 

 

 

mailto:CPU-E3-1246-V3@3.5GHz
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3.3. Diagram Alir Penelitian 

 

 

 

 

 

 

 

 

 

       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.1 Diagram Alir Penelitian 

Perumusan masalah 

Pemodelan menggunakan 

software Catia 

 

Variasi Diameter 
Tabung Silinder

  

Import to Ansys 

Simulasi Model Blok Silinder 

Kesimpulan 

Selesai 
 

Blok Silinder Diameter 

Tabung 102 mm 

 

Blok Silinder Diameter 

Tabung 104 mm 

Blok Silinder Diameter 

Tabung 100 mm 

Hasil Simulasi 

Static Structural 

 Mulai 

 

Total Deformation Equivalent Stress 
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3.4. Langkah Menggambar Blok Silinder 

Berikut ini akan dijelaskan gambaran singkat bagaimana proses 

penggambaran model blok silinder. 

1. Klik 2 kali ikon CATIA v5R19 pada tampilan awal desktop komputer. 

2. Setelah itu, muncul tampilan awal workbench. Untuk masuk ke menu 

part design, langkah yang harus dilakukan adalah dengan meng-klik 

menu “File” > klik “New” > pilih opsi “Part” pada kotak dialog New 

tersebut. Atau bisa juga dengan cara menekan tombol “Ctrl+N” pada 

keyboard dan setelah itu pilih opsi “Part” pada kotak dialog yang 

muncul. 

3. Setelah masuk ke tampilan part design, kita harus memilih sumbu yang 

akan kita gunakan sebagai acuan gambar kita nantinya. Hal ini dapat 

kita lakukan dengan memilih menu-menu sumbu yang ada disudut kiri 

atas tampilan part design. Disini terdapat 3 pilihan sumbu yang bisa kita 

gunakan sebagai acuan menggambar, yaitu sumbu x-y, sumbu y-z, dan 

sumbu z-x. 

4. Pada penelitian ini, saya selaku penulis menggunakan sumbu z-x 

sebagai acuan gambar saya, ini berarti saya memulai gambar dari 

pandangan depan.  

5. Setelah masuk ke lembar kerja (sketcher), disinilah kita membuat 

sketch pandangan depan dari blok silinder tersebut. Pada tahap ini 

sketch masih berupa bidang datar. 

6. Setelah sketch dibuat, klik perintah “exit workbench” untuk membuat 

sketch blok silinder tadi menjadi suatu bangun ruang, dengan 

menggunakan perintah “pad” pada toolbar yang ada di tampilan 

workbench tersebut. 

7. Selanjutnya, untuk membuat lubang-lubang seperti lubang tabung 

silinder, lubang oli, dan lubang-lubang saluran air, kita hanya harus 

memilih dari permukaan yang akan digambar dari bangun ruang yang 

sudah kita “pad” sebelumnya. 

8. Untuk proses ataupun tahapan menggambar berupa tampilan gambar 

dapat dilihat pada lampiran belakang tugas akhir ini. 
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3.5. Prosedur Penggunaan Software Ansys 

  Berikut akan dijabarkan secara singkat bagaimana tahapan ataupun 

prosedur utuk menggunakan software ansys. 

1. Klik 2 kali ikon ANSYS pada tampilan awal desktop komputer. 

 

 

 

Gambar 3.2. Ikon Ansys 

2. Setelah itu, muncul tampilan awal workbench. Di tampilan inilah kita akan 

memilih jenis pengujian apa yang akan digunakan, sehubungan dengan 

pengujian yang akan digunakan adalah pengujian statis, maka kita klik 

toolbar “Static Structural”.  

 

 

 

Gambar 3.3. Tampilan Awal Ansys 
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3. Selanjutnya akan muncul kotak dialog baru yang berisi beberapa menu. Kita 

pilih engineering data untuk memasukkan data berupa material pada model 

yang akan diuji. Caranya dengan meng-klik kanan pada menu Engineering 

Data >Engineering Data Sources > General Material > Gray Cast Iron > + 

>Engineering Data Sources > Gray Cast Iron >Return to project.  

 

 

 

Gambar 3.4. Cara Memasukkan Engineering Data 

4. Untuk memasukkan desain pemodelan yang akan di uji, maka pada kotak 

dialog tersebut kita pilih geometri. Caranya dengan meng-klik kanan pada 

menu Geometry>Import Geometry> file “iges”. 

 

 

 

Gambar 3.5. Proses Pemindahan Model ke Ansys Workbench 
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5. Setelah itu klik kanan pada menu Model>Edit. Maka kita akan dialihkan ke 

tampilan workbench ansys, disinilah proses simulasi pengujiannya akan 

berlangsung. 

 

 

 

Gambar 3.6. Tampilan Awal Ansys Workbench 

6. Setelah model masuk ke workbench ansys, lakukan pemeriksaan gambar 

dengan cara klik kanan pada menu Mesh>Generate Mesh. Dan tunggu sampai 

proses meshing ini selesai. Disini akan diketahui apakah model yang sudah di 

desain sebelumnya dapat di uji ataukah rusak dikarenakan terjadi kesalahan 

pada saat proses desain model tersebut.  

 

 

 

Gambar 3.7. Proses Meshing 
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7. Setelah proses meshing selesai dan desain model dipastikan aman, maka 

selanjutnya kita masuk ke pengaturan analisa dengan cara meng-klik kanan 

pada menu Static Structural>Insert> pengujian yang akan digunakan. Setelah 

itu atur arah dan besarnya beban yang akan diberikan ke model. Setelah itu 

tentukan titik dimana letak “Fixed Support” pada model, caranya dengan 

mengklik kanan pada menu Static Structural>Insert >Fixed Support. Setelah 

itu tentukan titik untuk fixed supportnya. 

 

 

 

Gambar 3.8. Menentukan Titik Pembebanan dan Fixed Support 
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BAB 4 

HASIL DAN PEMBAHASAN 

 

 

4.1 Hasil Pemodelan Menggunakan Software Catia v5R19 

 Variasi dari ketiga model desain blok silinder ini diambil dari ukuran 

diameter tabung silindernya. Pada model blok pertama, diameter silinder 

berukuran 100 mm. Sedangkan pada model blok kedua, ukuran diameter silinder 

adalah 102 mm. Dan pada model blok ketiga, diameter silinder memiliki ukuran 

sebesar 104 mm. 

 

 

 

Gambar. 4.1. Model Blok Silinder Diameter Tabung 100 mm 

 

 

 

Gambar. 4.2. Model Blok Silinder Diameter Tabung 102 mm 
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Gambar. 4.3. Model Blok Diameter Tabung 104 mm 

4.2. Hasil Pengujian Model Blok Silinder 

 Simulasiyang diterapkan pada ketiga model silinder ini adalah metode 

Static Structuraldengan sub metode Pressure. Dan posisi pembebanan berada 

pada silinder ke-4, dimana untuk mesin pembakaran dalam 6 silinder dengan 

urutan pengapian 1-5-3-6-2-4,  pada saat ini dinamakan posisi top 1 ataupun 

silinder nomor 1 sedang terjadi proses langkah kompresi, dan silinder ke-4 sedang 

terjadi proses langkah usaha, dimana terjadinya sebuah ledakan dari ruang bakar 

sehingga menyebabkan piston terdorong turun akibat tekanan dari ledakan pada 

ruang bakar tersebut, seperti yang ditunjukkan pada gambar 4.4. 

 Beban pengujian ini diasumsikan sebesar 27 bar, asumsi ini diambil 

berdasarkan tekanan kompresi normal dari sebuah mesin diesel yang berada di 

kisaran 275 PSI (19 bar) sampai dengan 495 PSI (34 bar). 

 

 

Gambar 4.4. Posisi Top 1 Mesin 6 Silinder 



45 

 

4.2.1 Hasil Pengujian Model Blok dengan Diameter Silinder 100 mm 

 

 

 

Gambar 4.5. Total Deformation Model Blok 100 mm 

  Berdasarkan hasil pengujian pada model blok dengan diameter 

silinder 100 mm, dengan pembebanan tekanan sebesar 27 bar (2,7 MPa) 

diperoleh nilai maksimal dari total deformasinya adalah sebesar 0,035391 

mm. 

 

 

 

Gambar 4.6. Equivalent Stress Model Blok 100 mm 

  Nilai minimal dari equivalent stress pada model pertama adalah 

sebesar 3,9043 x 10
-3

 MPa, sedangkan nilai maksimal dari equivalent 

stress adalah 127,78 MPa. 
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4.2.2 Hasil Pengujian Model Blok dengan Diameter Silinder 102 mm 

 

 

 

Gambar 4.7. Total Deformation Model Blok 102 mm 

  Berdasarkan hasil pengujian pada model blok dengan diameter 

silinder 102 mm, dengan pembebanan tekanan sebesar 27 bar (2,7 MPa) 

diperoleh nilai maksimal dari total deformasinya adalah sebesar 0,067331 

mm. 

 

 

 

Gambar 4.8. Equivalent Stress Model Blok 102 mm 

  Nilai minimal dari equivalent stress pada model kedua adalah 

sebesar 4,4328 x 10
-3

 MPa, sedangkan nilai maksimal dari equivalent 

stress adalah 130,89 MPa. 
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4.2.3 Hasil Pengujian Model Blok dengan Diameter Silinder 104 mm 

 

 

 

Gambar 4.9. Total Deformation Model Blok 104 mm 

  Berdasarkan hasil pengujian pada model blok dengan diameter 

silinder 104 mm, dengan pembebanan tekanan sebesar 27 bar (2,7 MPa) 

diperoleh nilai maksimal dari total deformasinya adalah sebesar 0,070973 

mm. 

 

 

 

Gambar 4.10. Equivalent Stress Model Blok 104 mm 

  Nilai minimal dari equivalent stress pada model ketiga adalah 

sebesar 6,2416 x 10
-3

 MPa, sedangkan nilai maksimal dari equivalent 

stress adalah 134,36 MPa. 
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4.3. Grafik Perbandingan Geometri dengan Total Deformasi 

4.3.1. Grafik Total Deformasi 

 

 

 

Gambar 4.11. Grafik Perbandingan Geometri dengan Total Deformasi 

   

  Dari grafik perbandingan diatas dapat diperoleh data nilai total 

deformasi untuk ketiga model blok silinder sebagai berikut: 

Tabel 4.1 Data Nilai Total Deformasi 

No Model Total Deformasi 

1 Diameter Tabung 100 mm 0,035391 mm 

2 Diameter Tabung 102 mm 0,067331 mm 

3 Diameter Tabung 104 mm 0,070973 mm 
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4.3.3. Grafik Tegangan Ekivalen 

 

 

 

Gambar 4.12. Grafik Perbandingan Geometri dengan Tegangan Maksimal 

   

  Dari grafik perbandingan diatas dapat diperoleh data nilai tegangan 

ekivalen untuk ketiga model blok silinder sebagai berikut: 

Tabel 4.2 Data Nilai Tegangan Ekivalen 

No Model Tegangan Ekivalen 

1 Diameter Tabung 100 mm 127,78 MPa 

2 Diameter Tabung 102 mm 130,89 MPa 

3 Diameter Tabung 104 mm 134,36 MPa 
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BAB 5 

KESIMPULAN DAN SARAN 

 

 

5.1 Kesimpulan 

 Berdasarkan hasil dari penelitian analisa numerik pada model blok silinder 

dengan menggunakan software Ansys diatas, dapat ditarik kesimpulan : 

1. Model blok silinder dengan diameter tabung silinder yang paling besar 

memiliki ketebalan dinding silinder yang paling kecil, sedangkan 

model blok silinder dengan diameter tabung silinder yang paling kecil 

memiliki ketebalan dinding silinder yang paling besar. 

2. Model blok silinder yang mempunyai ketebalan dinding tabung 

silinder lebih besar mendapatkan nilai total deformasi ataupun 

perubahan bentuk yang paling sedikit atau relatif kecil.Begitu juga 

sebaliknya, semakin kecil nilai ketebalan dari dinding tabung silinder 

sebuah blok silinder, maka semakin besar pula nilai deformasi ataupun 

perubahan bentuk dari struktur blok tersebut. 

3. Dan untuk nilai maksimal tegangan ekivalen yang didapat dari 

simulasi, model blok silinder yang mempunyai ketebalan dinding 

tabung silinder paling besar mendapatkan nilai tegangan ekivalen yang 

paling kecil, begitu juga sebaliknya. 

 

5.2 Saran 

Berdasarkan hasil dari penelitian analisa numerik pada struktur blok 

silinder dengan variasi geometri, saya menyarankan kepada penulis yang ingin 

melanjutkan ataupun melakukan penelitian dengan menggunakan metode analisa 

numerik, ada baiknya agar mempelajari dengan sebaik-baiknya bagaimana cara 

mendesain menggunakan software desain. Serta belajar bagaimana cara 

mengoperasikan software simulasi analisis yang digunakan untuk menganalisa 

secara simulasi digital dari sebuah komponen yang sudah di desain sebelumnya 

dengan menggunakan software desain. Dan pastikan perangkat penunjang seperti 

komputer yang digunakan untuk penelitian mempunyai spesifikasi yang mumpuni 

untuk menjalankan software ataupun program desain dan analisa. 



 

 

DAFTAR PUSTAKA 

 

 

Fenner, Roger T. (1996). “Finite Element Methods For Engineers”. London: 

Imperial College Press. 

 

Moaveni, Saeed. (1999). “Finite Element Analysis, Theory and Applicaation with 

ANSYS”. New Jersey: Prentice-Hall, Inc. 

 

Smallman, R.E. (2000). “Metalurgi Fisik Modern dan Rekayasa Material”. 

Terjemahan Oleh Sriati Djaprie. Jakarta: Erlangga. 

 

Hutton, David V. (2004). “Finite Element Analysis”. New York: McGraw Hill. 

 

Pinem, Mhd Daud, dkk. (2009). “Catia, Si Jago Desain Tiga Dimensi”. Surabaya: 

Lingua Kata. 

 

Zulkarnain. Irvan. (2011). “Blok Silinder”. Academia.edu. 

 

Choiron, Moch Adus, dkk (2014). “Modul Ajar Metode Elemen Hingga”. Malang: 

Departemen Pendidikan Universitas Brawijaya. 

 

R, Suresh, dkk. (2015). “Analisis Termomekanis Blok Mesin dari Mesin 

Pembakaran Dalam”: International Journal For Technological Research 

In Engineering. Volume 2: Hal 2698. 

 

Teguh, Rizani dan Sudiadi. (2015). “Metode Numerik”. Palembang. 

 

Annamneedi, Mukesh and Jithendra. (2016). “Desain dan Analisis Blok Mesin 

Empat Silinder Dengan Menggunakan Analisis Elemen Hingga”: 

International Journal & Magazine of Engineering, Technology, 

Management and Research. Volume 3:  Hal 443. 

 

Wikimedia Commons. (2016). Inline 6 Cylinder di 

https://commons.wikimedia.org/wiki/File:Inline_6_Cylinder_with_firing

_order_1-5-3-6-2-4.gif (diakses 18 November) 

 

Hadi, Syamsul. (2016). “Teknologi Bahan”. Yogyakarta: Penerbit ANDI. 

 

 

 

 

 

 

 

 

 

 

https://commons.wikimedia.org/wiki/File:Inline_6_Cylinder_with_firing_order_1-5-3-6-2-4.gif
https://commons.wikimedia.org/wiki/File:Inline_6_Cylinder_with_firing_order_1-5-3-6-2-4.gif


 

 

 

 

 

 

 

LAMPIRAN 

 

 

 
 



 

 

LAMPIRAN 

 

 PROSEDUR MENGGAMBAR BLOK SILINDER MESIN 

MENGGUNAKAN SOFTWARE CATIA 

1. Menjalankan Software Catia 

 
2. Menentukan Sumbu Awal Desain 

 
3. Memilih Menu Desain 

 
4. Tampilan Awal Part Design 



 

 

 

5. Membuat Sketch Body Blok Silinder 

 

6. Membuat Solid Sketch Body menggunakan Perintah Pad 

 

 

 

7. Membuat SketchWater Jacket 



 

 

 

8. Membuat Lubang Water Jacket menggunakan Perintah Pocket 

 

9. Membuat SketchDudukan Poros Engkol 

 

 

 



 

 

10. Membuat Solid Sketch Dudukan Poros Engkol dan Melubanginya Sesuai 

dengan Bentuk Poros Engkol 

 

 

 

 

 

 



 

 

11.  Membuat Lubang-Lubang Plug Air Pendingin 

 

 

12.  Membuat Sketch Lapisan Atas Blok Silinder (Dudukan Baut Kepala 

Silinder) 

 

 

 



 

 

13. Membuat Solid Sketch Lapisan Atas Blok Silinder  

 

14. Membuat Sketch Tabung Blok dan Lubang Oli 

 

15. Membuat Lubang Sketch Tabung Blok 

 

 

 



 

 

16.  Membuat Dudukan Mesin  

 

17.  Membuat Sketch Lubang Baut Kepala Silinder 

 

18.  Membuat Lubang Sketch Lubang Baut Kepala Silinder 

 

 

 



 

 

 Tampilan Layout Hasil Desain Pada Software Ansys 
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